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July 7, 2026 
 
NOTE: WebTMA mobile has new updates worth a look, such as a Show on Map feature. You can see 
them all here. 

 

Biomed Mass Import Now Accepts UDFs 
Path: Admin > Mass Import 
 

 
Add your UDF column to Biomed Template 

 
Create Import and expand Additional Mappings 

 
Locate UDF Field 

 
Rename the UDF Field to match your Column Name 
 

Summary: To increase the usability of User Defined 
Fields, you can add your own UDF columns to your 
Biomed Mass Import template.  

Details:  

Many Biomed clients have special requirements for 
fields specific to their organization. Using UDFs 
accommodates each Biomed client’s needs to search 
and generate reports. 

When you download the Biomed Template, you need 
to add your own UDF column names to be available in 
the Additional Mappings section. 

From Create Import in the application, the system 
auto-detects UDF columns. 

Expand the Additional Mappings section to re-map 
columns to match your field name prior to import. 

This feature will be added for other MWIs in the 
future. 
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Biomed and Equipment Mass Import Templates Enhanced 
 
Path: Admin > Mass Import 
 Biomed Template 

 
 
 Equipment Template 

 

Summary: A Regulatory Category column has been 
added to the Mass Import templates for Biomed 
Equipment and Equipment. 

Details:  

This column is found at the end of the columns in the 
template. 

The Regulatory Category drop-down options are  
defined in Organization > Lookups > Regulatory 
Categories. These are matched during the import 
process. 

If you are required to report to regulatory agencies, 
this field is used. You can quickly generate a list to 
give the agency when needed. 

 

AI Request Validation Summary Suggestions 
 

 
Path: Transactions > Request > Request Log 
 

Summary: The AI Assistant can help with speed and 
accuracy when converting a Request to a Work Order. 

Details:  

When a new Request is received, AI automatically: 

 queries past Work Orders for the same space 
or asset 

 provides a historical summary 

 predicts a diagnosis 

 pre-populates suggested field values on the 
Request Validation flyout (Task Type, Trade, 
Technician, etc.).  

 includes reasoning for each suggestion 

Once a new Request is received, the system gathers 
the information. At times there may be a short delay 
if you open a very recent record.  

When you click the Accept button, you see fields with 
suggested values on the Request Validation flyout. 

Suggested fields are identified with a sparkle  icon. 

Look to the bottom of the flyout for the Saved 
suggestion reasoning box for explanations about the 
suggestions. 

NOTE: This feature is automatic if you have OTTO 
enabled. Currently it is not enabled for requests using 
Auto Attendant. 
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OTTO Polls Numerous Windows 
 

 
Path: Landing Page 
 

Summary: When you query OTTO from the Landing 

Page using the  icon at lower left, the search has 
expanded beyond Work Orders. A list of the windows 
now included in OTTO’s search can be found here. 

Details:  

TMA continues to improve the use and scope of our AI 
assistant to help you accomplish your goals more 
quickly and accurately. 

Additional windows will be added in the future. 

 

Task Sheet Field Has AI Enhancements 
 

 
Path: Organization > Task > Records 
 

Summary: You can improve the contents of your 
Task Sheets with AI. This gives you a faster way to 
create something easy for technicians to understand 
without writing everything from scratch 

Details:  

If the field already has text, click the Auto-generate 
button. This uses AI to rewrite it and improve existing 
content - making it easier for Technicians to read. 

When the field is empty, click the button to have AI 
write a draft based on the Task Description. 

The enhancement is only available if you mark the 
Use Rich Text check box.  

AI uses MarkDown (or rich text). Note the alert above 
the Task Sheet field. If you print Work Orders, it may 
show MarkDown characters, which can be confusing 
to readers. 
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June 23, 2026 
 

VOC – Requestor Email Search Enhancement on SRP Search Page 
 

 
Path: Admin > Form Attributes > Service Request 
Portal 

 
 
 

Summary: On the Service Request Portal (SRP) 
Search page, you now have the option to search by 
email alone - no Request # needed. 

Details:  

In addition to making the Request # optional, a new 
grid replaces the previous single-result redirect. The 
grid shows all requests tied to an email address. 

The contents on the grid can be rearranged with 
filtering and sorting, similar to the Status page 
attributes. 

Logged-in users see the results immediately if their 
email address matches the Request record. 

Anonymous users enter their email address from the 
new Request Browse form to receive an email with a 
one-time link. When they click the link, they go to the 
page with all their requests. Note that this is required 
for anonymous users, but regular users can also use 
of the form. 

As long as the email address is on the original request 
both types of users see a list of all their requests.  

This is the June Voice of the Customer enhancement. 
It is a feature requested by Azusa Pacific University. 
We saw an opportunity to redevelop the page to be 
more user-friendly. WebTMA has evolved into the 
solution it is largely through great feedback and 
suggestions provided by our clients. 

 

Task Average Hours Action Enhanced 
 

 
Path: Organization > Task > Records 
 
 

Summary: You can now reset the Task Average Time 
if needed.  

Details:  

Previously, you could update the field manually; 
however, the field reverted to its former value the 
next day. This is due to the automated Task Average 
Time batch job that runs every 24 hours and 
recalculates the average time using all historical labor 
data. 

The Average Time (hrs) field is now read-only.  

A new Average Time Start Date field has been added 
immediately below the Average Time (hrs) field. 

This new date field controls the calculation window. 
The date can be any time in the past. When a date is 
entered, the nightly batch job only considers closed 
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Work Orders completed on or after that date rather 
than all historical data. 

This ensures manual overrides are preserved while 
still allowing the system to continue automatic 
recalculations going forward. 

If the field is empty, the batch calculates across all 
history as usual. 

NOTE: The Recalculate Task Average Time found on 
the Client Info Action Menu also respects the manual 
start date — it only uses labor history after the most 
recent manual update timestamp. 

 

Acknowledgement Restrictions Removed on WO Action Menu 
 

 
Path: Transactions > Work Order > Records – Action 
Menu 

Summary: Use of the Acknowledge link on the Work 
Order window is available for use on all WOs. It is no 
longer restricted to Notification and Escalation 
settings. 

Details:  

Previously, the link was disabled unless it was tied to 
Notification and Escalation. 

The constraint has been removed so all Work Orders 
can be acknowledged. If it is multi-task, you are 
asked if you want to acknowledge all. You have the 
choice to select the tasks you want to acknowledge. 

Acknowledgement populates the Acknowledged By 
and Acknowledgement Date fields in the Task Section. 
The fields are read-only. For multi-task WOs, the 
information is completed in the same columns in the 
grid. 

When all tasks are acknowledged, the Acknowledge 
link is disabled. 

Note: You can continue to use the Require 
Acknowledgement check box on the Notification and 
Escalation window as before. 

 

Virtual Facility (VF) Alarm Status Shown in Request Log 
 

 
Path: Transactions > Request > Request Log 

Summary: If you use Virtual Facility to monitor 
alarms, the Request Log window Action menu will 
include a Show Alarm Status link. 

Details:  

Click the link to open the Alarm Details flyout. This 
gives you the information needed about the alarm 
without leaving WebTMA. 
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SRP Item Type Field Now Allows Restricted Values 
 

  

  
 

  
Path: Admin > Form Attributes > Service Request 
Portal 

Summary: When you build your Service Request 
Portal (SRP) Form, you can now control which values 
requestors see in the Item Type drop-down selection. 

Details:  

Rather than displaying all Item Types for your 
requestors, you can choose which values are 
applicable to requestors. 

Click the gear icon to open the Edit Block Settings 
popup. Note that all available check boxes in the 
Available Options section are marked. This indicates 
that all options will be visible to the requestor. 

If you want to limit the item types, clear the check 
box for any Item Type your user should not see. 

Note: If all check boxes are cleared, the system 
views them as marked and will display all Item Types. 
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June 9, 2026 
 

Acknowledge Icon Added to Landing Page – Active Tasks Tab 
 

 
Path: Landing Page / Active Tasks Tab 
 

 

Summary: Technicians have the option to use the 

new  Acknowledge icon on the Landing Page to let 
others know they have received a Work Order. 

Details:  

Since not all Technicians use WebTMA mobile, this 
allows all Technicians to use the Acknowledge 
feature. 

When clicked, a popup ‘Success’ reminder displays. In 
addition, the current date is added to the Work Order 
- Task Information section in the Acknowledged Date 
field. Once clicked, the icon is disabled to prevent 
multiple acknowledgements. 

Note that this Acknowledgement is not dependent on 
the Notification and Escalation rules and any user can 
mark these lines as Acknowledged. 

 

Source Field Now Available in SRP 
 

  
Path: Admin > Form Attributes > Service Request 
Portal  

Summary: The Service Request Portal (SRP) has a 
new Source field you can add to your forms. 

Details:  

Our clients want to identify their SRP requests using 
the terminology they create in Organization > 
Lookups > Sources.  

Use of this field gives immediate information about 
the source. 

Adding the new Source field to a Form saves both 
manual effort and extra clicks to see this information. 
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AI SmartScheduler Dashboard Enhanced for Supervisors 
 

 
Path: Transactions > Time Manager > AI Smart 
Scheduler 

Summary: The AI SmartScheduler now filters Trades 
for Supervisor users. 

Details:  

Previously, the Supervisor saw every Trade available 
through their Repair Center access.  

Now the system checks if the logged-in user has a 
Technician record marked as Supervisor. When this is 
true, the Trade list is filtered to show only Trades 
where the user is assigned as Supervisor. 

With this enhancement, Supervisors only see the 
Trades they oversee, which helps reduce the amount 
of data they must review. It makes use of the tool 
faster and easier. 

This change is based on feedback from the TMAi 
Board, and we appreciate their insight and 
suggestions.  

 

 



  9 

May 26, 2026 
 

PO Counters Available by Repair Center 
 

  
Path: Organization > Repair Center > Records / 
Identity Tab–Preferences Section 

Summary: You now have the option to set Automatic 
Purchase Order Counters and Prefixes by Repair 
Center rather than globally. 

Details:  

Three new fields have been added to the Preferences 
section of the Identity Tab: Auto PO Counter, PO 
Prefix, and Counter.  

When you mark the three fields, Purchase Orders with 
that Repair Center populated on the record use the 
prefix and count value designated on the Repair 
Center Preferences. 

If you need to track purchases by Repair Center, this 
new feature is a quick and easy way to do so. 

You also have the option to set the global counter on 
the Admin > Client Info / Counters Tab. If both are 
set, the Repair Center settings are used. 

 

Creator Column Added to WO Results Tab Comment Section  
 

 
Path: Transactions > Work Order > Records / Results 
Tab 

  
Path: Transactions > Work Order > Records / Results 
Tab 

Summary: A new Creator column has been added to 
the Work Order / Results Tab in the Comment 
Section. This identifies the person who made the 
comment. The column was also added to the Find 
Criteria list. 

Details:  

Previously, comments made from WebTMA mobile 
were not seen in the main application. With this new 
column, the creator of the comment is identified. 

In addition, the new column has been added to the 
Criteria drop-down, which makes it searchable and 
reportable. 
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Linked Documents Section Enhanced 
 

 

Summary: As a follow-up to the Linked Documents 
grid released on May 12, the Linked Documents 
section in the Navigation panel has been improved. 

Details:  

Previously, the section could be displayed in two 
states using the toggle icon : 

 Grouped by file Type 

 Grouped by Entity (e.g., WO, Asset, etc.)  

The revised view can be displayed in three states: 

 Grouped by file Type 

 Grouped by Entity (e.g., WO, Asset, etc.) 

 Grouped by file Category 

The toggle icon has been changed to a cyclical icon 
. 

 

Copied User Groups Now Retain Preferences/Privileges 

 
Path: Admin > User Management > Groups / 
Preferences Tab 

Summary: When you copy a User Group record, the 
copied record now has the same Preferences and 
Privileges. 

Details:  

Previously, a copied Group record did not save the 
contents of the Preferences Tab. 

With this enhancement, you can clone different 
Groups without having to add new Preferences or 
Privileges. Of course, you can always make changes 
to the copied record but having a base will save time. 
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CAD Import Queries Available to Dashboard Controls 
 

 
Path: Dashboard / Add New Control 

Summary: If you have the Space Management 
module, you can now select CAD Import for your 
Dashboard controls. 

Details:  

The Base Window drop-down list now includes CAD 
Import. 

Previously, the selection was not available. 

Reminder: This option is only visible if you have the 
Space Management module. 

 
 

Requests Converted to Projects Now Include Estimates 

        
Path: Transactions > Request Log  
 

       
 

Summary: When a Request Log record has an 
attached Estimate and is converted to a Project, the 
new Project inherits the associated Estimate. 

Details:  

Previously, the system did not include Estimates 
attached to a Request. Now, if the Request Log has 
an Estimate, the Project inherits the Estimate from 
the Request Log. 

You can identify the presence of an Estimate by 
looking at the Action Menu. If the Estimate link is 
bolded and bounded by asterisks (*Estimate*), it 
alerts you that the record has an Estimate. 

Note that any changes to the Estimate must be made 
from the Project record. Changes made are not 
reflected on the Request Estimate record. 

Path: Transactions > Project > Records 
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Custom Item Type Labels Now in SRP 
 

 
 

 
Path: Admin > Text Management 

Summary: The SRP (Service Request Portal) now 
displays Text Management Item Type label 
customizations. 

Details: 

Previously, when a client renamed Item Type labels in 
the application (e.g., "Equipment" renamed to "Asset"), 
those changes were not reflected in the SRP.  

You can now see Item Type custom text in the SRP 
Item Type dropdown. 

To add the custom labels: 

1. Go to Admin > Text Management. 

2. Enter New UI Forms in the Form Name field. 

3. Click the Search button to see all lines. 

4. Click the Control column filter. See illustration 
at left, to filter for Item Type > List.  

5. Follow the standard procedure to add new 
labels to the Custom Text column. 

Any custom text entered here is now reflected in the 
SRP drop-down. 

More information about adding custom text is 
available at 
https://knowledgebase.tmasystems.net/hc/en-
us/articles/7873531021965-Text-Management-
WebTMA-7. 
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May 12, 2026 
 

VOC – Linked Documents Enhancements 
 

 
Path: Linked Document List flyout 

Summary: The Paper Clip icon  on the toolbar of 
any record that has Linked Documents has been 
improved to make it more meaningful and easier to 
use. Labels have been revised for clarity. 

Details:  

When you click the Paper Clip icon , it opens a 
read-only flyout grid that shows the document 
details, a thumbnail, and the document type. 

Click the thumbnail in the first column to do the 
following: 

 File icon – Download the file 

 Image icon – Open a full size image in a new 
browser tab 

 Link icon – Opens the link in a new browser 
tab 

Two column labels have been reversed for better 
understanding. The Category is now Type and 
Document Type is now Category. In the Category, 
your selections include options from Lookups > 
Document Types. 

This is a May Voice of the Customer enhancement. It 
is a feature requested by clients converting from 
WebTMA 5 to WebTMA 7 as well as others in the 
Community. We saw an opportunity to redevelop the 
page to be more user-friendly. WebTMA has evolved 
into the solution it is largely through great feedback 
and suggestions provided by our clients. 

 

Dashboard Queries Enhancement 
 

              
No Distinct Setting          With Distinct Setting 

Summary: If you use Executive Dashboard graphic 
displays, you now have the option to Show only 
distinct values from the query’s result for records 
which previously appeared to give “duplicated” 
results.  

Details:  

When you mark the Show only distinct values from 
the query’s result check box, only one count is 
included.  

Previously, if you had a Dashboard Control with Work 
Orders and a column for multi-tasks or schedules, a 
value for each instance was returned. For example, a 
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Path: Files > My Dashboard 

Work Order with three Tasks was counted three 
times. 

When you opt for distinct values, you can drill down 
to Task level of the record for details about a Work 
Order. 

If the query has no multi-task or schedule records, it 
returns the same data with or without the “distinct” 
check box marked. 

This enhancement applies to all four graphic types: 
Bar Chart, Pie Chart, Digital, and Dial Gauge. It has 
been requested over the years in many Community 
suggestions. 

 

 

Acknowledgement Enhancements 
 

 
 

 
Path: Transactions > Work Order > Records 
 

Summary: The Acknowledgement fields for Work 
Orders have been relabeled and enhanced for clarity 
and better visibility.  

Details:  

The Acknowledgement label on the Work Order / 
Identity-Task Information section has been changed 
to Acknowledgement Required. 

For single-task Work Orders, Acknowledged By has 
been added as a read-only field below the 
Acknowledged Date field. These two fields are visible 
on the single-task Work Order only when they are 
populated. 

In the Find flyout on the Work Order window, the 
Acknowledged User Initial query option has been 
replaced by Acknowledged By. 

These fields are populated when a Work Order is 
acknowledged from either the main application or 
WebTMA mobile. 
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Path: Transactions > Work Order > Records-Find 

 

Work Order Customer Survey Improvements 
 

  
Path: Transactions > Work Order > Records-Action 
Menu 

 
         Flyout for Enter Survey Results 

Summary: A new Work Order Action Menu link 
(Download Survey Results) and a relabeled link 
(Enter Survey Results) have been added to the Work 
Order Action Menu.  

Details:  

When you click the new Download Survey Results 
link, WebTMA automatically downloads the results in 
a .pdf file to a browser tab. 

The previous Survey Results label was renamed Enter 
Survey Results for clarity. When clicked, the Survey 
Result flyout opens to allow you to enter results 
manually if needed. 

These changes help you be more efficient by 
providing quick access to the completed survey data 
directly from the Work Order without having to open 
other windows or perform manual data extraction. 
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OTTO Now Searches the Knowledge Base 

 
 

Summary: OTTO, the new AI Work Order Assistant, 
now draws from the WebTMA Knowledge Base to help 
answer your questions.  

Details:  

When an appropriate article is found, OTTO gives you 
a summary of how-to steps as well as a URL to see 
the complete article in the Knowledge Base. 

 

Custodial Template Query Additional Fields 
 

 
Path: Transaction > Custodial > Custodial Template 

Summary: More fields have been added to the 
selection drop-down for the Custodial Template 
window.  

Details:  

The following have been added for selection: 

 Active 

 Repair Center Code 

 Repair Center Name 

 Repair Center Preferred 

For those who use the additional Custodial module, 
this provides a way to search for records for the 
specific characteristics. 
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Transfer Parts Budget Code Criteria Added 
 

 
Path: Material > Parts > Transfer Parts 

Summary: The Transfer Parts query window now 
includes Budget Code as a criterion.  

Details:  

This addition allows you to set up a query to track or 
search for specific Budget Codes or for transfers 
without a Budget Code. 
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April 28, 2026 
 

VOC – Total View Enhancement 

 
Path: File > Total View 

Summary: The Total View window now shows both 
the Code and Description as well as Type and 
Subtype if it exists.  

Details:  

If your naming conventions or descriptions are 
generic, the additional information helps you identify 
the correct item and location. 

This is an April Voice of the Customer enhancement. 
It is a feature requested by New York State 
Department of Environmental Conservation. We saw 
an opportunity to redevelop the page to be more 
user-friendly. WebTMA has evolved into the solution it 
is largely through great feedback and suggestions 
provided by our clients. 

 

VOC – Lease Records Show Tenant & Landlord Simultaneously  
 

 
Path: Organization > Lease Management > Records / 
Identity Tab 
 
 

Summary: Both the Tenant and the Landlord are 
visible on all Lease records.  

Details:  

Previously, either the Tenant was visible for a 
Landlord record, or the Landlord was visible for a 
Tenant record. 

This change allows you to generate a Report that 
includes both or to make a printed copy. 

This is an April Voice of the Customer enhancement. 
It is a feature requested by University of Minnesota 
College System. We saw an opportunity to redevelop 
the page to be more user-friendly. WebTMA has 
evolved into the solution it is largely through great 
feedback and suggestions provided by our clients. 
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OTTO – AI Work Order Assistant 
 

 
Path: Landing Page-Single Work Order OTTO Popup 

Summary: Our AI Work Order Assistant called OTTO 
gives you answers to questions about details, history, 
or other information about a Work Order. You can 
search for “how do I…” instructions and ask questions 
in real time. If you want to know what OTTO can do 
for you, click a starter question. 

In addition to the Landing Page access mentioned 
below, User records have a new Enable Otto setting in 
Admin > User Management > Records / Preferences 
that must be granted. 

Details:  

OTTO is an AI-powered assistant in WebTMA that 
helps users quickly get answers such as work order 
history, recurring issues, and other questions. 

You can diagnose and resolve problems for specific 
work orders faster without manually searching 
through records or linked documents. 

Currently, OTTO is available on the Landing Page and 
the Browse Query window (described in the next 
topic). If you have not Granted access to the Landing 
Page yet, follow the easy instructions here. 

On the Landing Page, you can ask questions about a 

specific Work Order using this icon  found with 
other icons on the Work Order line.  

For more general Work Order questions use this icon 

 at the lower right. 

A more comprehensive description of OTTO with tips 
for example prompts is here.  

 

OTTO and Browse Queries 
 

 
 

Summary: In addition to the Landing Page, OTTO is 
also present on the Browse Queries window. 

Details:  

Here the OTTO window opens once you select a Form 
and Query. Like other OTTO windows, you can ask 
questions about the data. 

You can display the data in a list or graphically where 
applicable. Click the  button once the list is 
displayed.  
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Path: Reports > Browse Queries 

 

Technician Role Now Has ‘Add’ for Request Log Window Access 
 

 
Path: Admin > User Management > Records / Window 
Access Tab 

Summary: ‘Add’ permission has been included in the 
Technician Role selections for Request Log on the 
User / Window Access Tab. 

Details: 

Previously, the only options were Read, None, or Not 
Determined. 

This enhancement was made to allow Technicians 
who use WebTMA mobile to use the Request function. 

Previously, only those with a User Role could add a 
request from WebTMA mobile. 

NOTE: Technicians who log in to the main application 
can also add requests directly to WebTMA when this 
permission is added. 

 

New Client Info Preference for Inspections Pass All 
 

 
Path: Admin > Client Info / Preferences Tab–Work 
Orders 

Summary: If you use the additional General 
Inspections module, you have the option to show or 
hide the Pass All check box on the Inspection or Item 
Check List flyouts. 

Details:  

When the Show Pass All on Inspections Preference is 
Granted, the Pass All check box is shown. 

If you want to allow your Technicians to use the Pass 
All option, Grant the Preference.  

This applies only to General Inspections in the web 
application because the web version of Master Checks 
does not have the option. 

For WebTMA mobile, this applies to General 
Inspections and Master Checks because the option is 
available for both on the mobile device. 
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Cost Unit of Measure for WO and QP 
 

 
Path: Transactions > Work Order > Records / Costs 
Tab-Post Other 
 

 
 
Path: Transactions > Work Order > Records / Costs 
Tab-Work Order Cost Entry 

Summary: The Post Other costs option on the Work 
Order / Costs Tab and in Quick Post > Quick Post 
Other Charges now have the option to indicate the 
type of Unit for non-maintenance-worthy items.  

Details:  

Previously, the field only allowed you to select rental 
time periods. 

If you leave the default Item Tag on display and do 
not select an MWI item, you can enter your own 
Description and choose a Unit that corresponds to the 
object. 

The selections available are those that you have 
created in Organization > Lookups > Units of 
Measure. 

This new feature allows you to enter the appropriate 
unit for more than just rental of MWI items. 
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Request Conversion to Project Includes Linked Documents 
 

 
Path: Transactions > Project > Records 
 

Summary: When a Request is converted to a Project, 
any linked documents with the Request are also 
attached to the Project.  

Details:  

Previously, the attached document was not added to 
the Project record. 

This allows all information made with the Request to 
be included on the Project record. These can include 
linked documents and images provided by a requestor 
for projects like event planning and large remodels.  
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April 14, 2026 
 

VOC – eSignature Added to User Record 
 

  
Path: Admin > User Management > Records (Edit 
mode) 
 

 
Path: Admin > User Management > Records (Edit 
mode) 

  
Path: Material > Purchase > Purchase Orders-Reports 

Summary: You can now store a signature with a 
User record that can be applied to a specific Purchase 
Order report.  

Details:  

The Signature link on the User record Action menu is 
available in Edit mode. Click the link for the same 
standard Signature Entry process used with Keys and 
other modules. 

Purchase Order records that are approved are 
stamped internally with the authorizer’s User ID.  

When you run the report named Purchase Orders with 
Authorized Signature (available on the Purchase 
Order window), the authorizer’s signature is 
automatically applied to the report if it is authorized 
by a user with a stored signature. 

This allows you to print an electronic or paper report 
with a signature.  

This is an April Voice of the Customer enhancement. 
It is a feature requested by Empresas Fonalledas. We 
saw an opportunity to redevelop the page to be more 
user-friendly. WebTMA has evolved into the solution it 
is largely through great feedback and suggestions 
provided by our clients. 

 

 

VOC – SRP Building & Area Fields Include Second Line 
 

  
 

Summary: When you use a Building or an Area field 
in your Service Request Portal forms, a second line is 
automatically included.  

Details:  

The Building selection drop-down includes the 
contents of both the Building Name field and Address 
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Path: Admin > Form Attributes > Service Request 
Portal 

Line 1 field as seen on the Organization > Building / 
Identity Tab. 

The Area selection drop-down includes the contents of 
both the Area Location ID and the Area Description as 
seen on the Organization > Areas / Identity Tab. 

This change helps your Technicians easily locate the 
site where work is to be performed. 

This is an April Voice of the Customer enhancement. 
It is a feature requested by Banner Health. We saw 
an opportunity to redevelop the page to be more 
user-friendly. WebTMA has evolved into the solution it 
is largely through great feedback and suggestions 
provided by our clients. 

 

Service Request Form Forwarding to Service Request Portal 

 
Path: Admin > Form Attributes > Service Request 
Form 

Summary: The Service Request Form (SRF) is not 
WCAG 2.1 compliant; however, Service Request 
Portal (SRP) forms are compliant. If your request 
forms need to be WCAG 2.1 compliant, you can now 
forward an existing URL to an SRP.  

We have created this option for clients who don’t 
want to deploy new URL links or pages to users or a 
web site. A new field on the SRF window allows you 
to forward the URL to an existing SRP form.  

Details:  

The first requirement is that you have forms in the 
SRP. You can redesign or reuse the layout from your 
SRF forms.  

The SRP forms meet the new accessibility standards. 

Go to the Admin > Form Attributes > Service Request 
Form window: 

1. Open the desired record. 

2. Edit the form. 

3. Use the new Forward to Service Request 
Portal form field drop-down. 

4. Select one of the SRP forms. 

5. Save. 

The SRP form uses the original URL sent to your users 
for Service Request Forms. 

NOTE: This does not apply to those who use the 
Requestor Login. 
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March 24, 2026 
 

Workday Procurement Integration 
 

 
Path: Admin > Workday > Integration Log 
 
 

 
Path: Material > Purchase > Purchase Requisitions 

Summary: A new turnkey Workday integration for 
Procurement is now available. This is an additional 
module. 

Details:  

If you are a Workday client, you can use this new 
module to automatically integrate and sync your 
purchasing workflow between WebTMA and Workday. 
The two are fully integrated. No setup coding or IT 
involvement are needed. All you need are a few 
portal keys from Workday. 

The module does the following for WebTMA 7 records 
that have a Workday reference: 

Validate Vendor. Connects WebTMA 7 to 
Workday to authenticate Vendors in WebTMA 
and ensure vendor data consistency between 
both systems. Polled daily. 

Validate Part. Connects WebTMA 7 to Workday 
to validate Part records and maintain alignment 
of inventory across platforms. Polled every 10 
minutes. 

Export Purchase Requisitions. Export 
Purchase Requisitions from WebTMA 7 to 
Workday and streamline requisition processing in 
Workday. Polled every 10 minutes. 

Import Purchase Order. Import Purchase 
Orders created in Workday into WebTMA 7 
and ensure visibility of Workday-generated POs 
in WebTMA. Polled every 10 minutes. 

Export PO Change Order. Modify the Workday 
Purchase Order after it has been sent to Workday 
by exporting a PO Change Order from WebTMA 
to support change order processing and 
synchronization between systems. Polled every 
10 minutes. 

Export On-Hand Adjustment. For received 
items, automatically send adjustment lines from 
WebTMA 7 to the related Workday Purchase 
Order to align inventory and financial data 
following adjustments. Polled every 10 minutes. 

Export Invoice Information. Send Accounts 
Payable Invoice information from WebTMA 7 to 
Workday and facilitate financial processing and 
tracking in Workday. Polled every 10 minutes. 

See a Consolidated View. The Integration Log 
in WebTMA 7 shows a list of every inbound or 
outbound action that has taken place between 
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WebTMA 7 and Workday for traceability and 
troubleshooting of integration activities.. 

The following windows include a Workday section like 
the example at left: 

• Purchase Requisition 
• Purchase Order 
• Vendor 
• Accounts 

Enabling this interface creates a seamless integration 
between Workday and WebTMA 7, which eliminates 
manual data entry and reduces the risk of 
discrepancies between systems. This ensures that 
procurement and maintenance operations stay 
aligned in real time. 

Please contact your account manager for details on 
acquiring this new module. 

 

New Repair Center Preference – Populate WO Estimated Hours 
 

 
Path: Organization > Repair Center > Records / 
Identity Tab 

Summary: A new Populate WO Estimated Hours 
check box has been added to the Preferences section 
of the Repair Center window. 

Details:  

When the box is checked, it enables automatic 
completion of the Estimated Hours field on the Work 
Order window. 

See the next topics for a discussion of this feature. 

 

Auto-Complete Estimated Hours for Non-PM Work Orders 
 

 
Path: Transactions > Work Order > Records / Identity 
Tab 

Summary: If your Repair Center has the Populate 
WO Estimated Hours Preference checked (see the 
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previous topic), the Estimated Hours field on the 
Work Order window can be completed automatically. 

Details:  

WebTMA uses values from the Task window Labor 
Standard field.  

If the WO has multiple Tasks, WebTMA calculates the 
sum of Labor Standard values from all Tasks. 

With this new feature, you know at-a-glance the 
hours needed to complete the work. 

When the conditions are met, the feature also applies 
to Work Orders created using Auto Attendant or 
Inspection Findings. 

If you manually enter a value in the Estimated Hours 
field, the feature does not override your entry. 

 

Auto-Complete Estimated Hours for PM Work Orders 
 

 
Path: Transactions > Work Order > Records / Identity 
Tab 

Summary: If the PM Repair Center has the Populate 
WO Estimated Hours Preference checked, the 
Estimated Hours field on the Work Order window can 
be completed automatically.  

Details:  

WebTMA looks to the Est. Time field on the PM 
Schedule Entry flyout for a value.  

If no value is entered on the flyout, the Labor 
Standard from the Task window is used. 

With this new feature, you know at-a-glance the 
hours needed to complete the work. 

If neither of these windows contains a value, the WO 
Estimated Hours field remains blank. 

If you manually enter a value in the Estimated Hours 
field, the feature does not override your entry. 

 

WO Audit History Shows Time & Attendance Labor Cost 
 Summary: The Show Audit History on the Work 

Order Action Menu now includes entries that are 
made from the Time Manager > Time & Attendance 
window. 

Details:  

We have expanded the Work Order - Show Audit 
History window to include information from Time 
Manager > Time & Attendance. With this 
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Path: Transactions > Work Order > Records-Show 
Audit History 

enhancement, you can now see labor entered from 
this window. 

You no longer have to track down information from 
several sources. Now you can see it in one place. 

With this enhancement, you can see labor cost 
entries on the Audit History window that originated 
from the Work Order / Costs Tab and the Time & 
Attendance window. 
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March 17, 2026 
 

VOC – Requestor Information Retained on WO Copy 
 

 
Path: Transactions > Work Order > Records 

Summary: When you copy a Work Order, you now 
have the option to retain the Requestor fields (name, 
phone, email) information. 

Details:  

Previously, when you clicked Copy on the WebTMA 
toolbar, the contents of the Requestor fields were not 
carried over to the copied record. 

With this release, a prompt asks if you wish to retain 
the original Requestor information. Click OK to keep 
the information, Cancel to remove it. 

Some clients prefer to keep the original Requestor, 
but others do not. This is another way WebTMA 
continues to give all our clients options to maintain 
their individual workflow process. 

This is a March Voice of the Customer enhancement. 
It is a feature requested by Dallas College in the 
WebTMA Community. We saw an opportunity to 
redevelop the page to be more user-friendly. WebTMA 
has evolved into the solution it is largely through 
great feedback and suggestions provided by our 
clients. 

 

VOC – New OHA Query Column ‘Part Total Cost’ 
 

  
Path: Material > On-hand Adjustments-Find 

Summary: A new column selection, Part Total Cost, 
has been added to the Find flyout for the On-Hand 
Adjustments window. 

Details: 

The new column is calculated as: 

 Unit Cost x Quantity = Part Total Cost 

While the information has been available in a 
standard report, this new column gives you 
immediate information about the total cost impact of 
any adjustments, and it can be used to display 
statistics on the Dashboard. 

This is a March Voice of the Customer enhancement. 
We would like to thank ZF Lifetec for submitting this 
suggestion. We saw an opportunity to redevelop the 
page to be more user-friendly. WebTMA has evolved 
into the solution it is largely through great feedback 
and suggestions provided by our clients. 
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VOC – StarRez Integration Notification Configuration 
 

 
Path: Admin > Client Info / Preferences 

Summary: If you use the StarRez interface to submit 
requests to WebTMA, you can elect to notify the 
requestor when StarRez requests are updated. 

Details:  

If you Grant Send Email Notifications in Client Info / 
Preferences, WebTMA sends notifications to your 
customers that submitted the request. 

We know not all clients want this as the default, so 
we made it a Client Info / Preference. By default, 
the setting is Denied which was the previous 
behavior in WebTMA 7. If you want to use it, be 
sure it is Granted. 

Customers that submitted a request from the StarRez 
Portal will receive the same notifications that have 
been configured in your WebTMA application.  

NOTE: If you use our API Platform, you can set the 
Notify Me feature there instead. In the API call, you 
can update how you call the StarRez Integration API 
and include the NotifyMe parameter in the payload. 

This is a March Voice of the Customer enhancement. 
We would like to thank George Fox University, the 
University of San Diego, the University of Louisiana at 
Lafayette, and others for submitting this suggestion. 
WebTMA has evolved into the solution it is largely 
through great feedback and suggestions provided by 
our clients. 

 

Mass Import – Equipment and Vehicles Have New Fields and URL 
 

 
Path: Mass Import / Templates 
 

Summary: The Mass Import Templates for 
Equipment and Vehicles now include an option for 
Linked Document URLs and several more fields. 

Details:  

The template allows you to enter URLs in the 
template and supports www.google.com, https://ww
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w.google.com, and the pipe (|) to separate multiple 
URL entries. 

Having these new fields and the Linked Document 
URL allows for more accuracy and saves you time and 
keystrokes. 

Here is a list of the new fields: 
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March 3, 2026 
 

API – OHA Endpoint for PO Receipts 
 

 
 

Summary: An On-Hand Adjustment for Purchase 
Order Receipts now has a GET API endpoint added to 
the API Platform. 

Details:  

You can use this endpoint to allow your external ERP 
software to call for Purchase Order received. 

This feature is valuable to assure accuracy and save 
time. 

 

WO Show Audit History Now Shows QP Part/Material Costs 
 

 
Path: Transactions > Work Order > Records / Action 
Menu-Show Audit History 
 

Summary: The Show Audit History on the Work 
Order Action Menu now includes Part cost entries that 
are made from Quick Post windows. 

Details:  

We have now expanded the Work Order - Show Audit 
History window to include information from Quick 
Post Cost and Quick Post Material. With this 
enhancement, you can now see Parts and Materials 
entered from Quick Post. 

You no longer have to track down information from 
several sources. Now you can see it in one place. 

With this enhancement, you can see cost entries on 
the Audit History window that originated from the 
Work Order / Costs Tab, specific Quick Post windows, 
and from the new WebTMA mobile application. 
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February 17, 2026 
 

Technician Mass Import Now Supports Multiple Trades 
 

 
Path: Admin > Mass Import / Templates 
 

Summary: The new Technician Template for Mass 
Import now supports importing multiple Trades for 
Technicians. 

Details:  

This new feature allows you to save time by importing 
new or updated information about your Technicians 
such as multiple Trades and multiple Repair Centers.  

Using this feature, you can easily update charge 
rates, reclassify your Technicians, or add new 
employees with a single import. 

When you have multiple Trades or Repair Centers, 
separate the entries using the vertical bar or pipe (|) 
with no spaces between entries. 

 

WO Show Audit History Includes Cost Events from Quick Post 

 
 
Path: Transactions > Work Order > Records / Action 
Menu-Show Audit History 

Summary: The Show Audit History on the Work 
Order Action Menu now includes cost entries that are 
made from Quick Post windows.  

Details:  

We expanded the Work Order - Show Audit History 
window to include information from Quick Post Cost, 
Time & Labor, and Other. You no longer have to track 
down information from several sources. Now you can 
see it in one place. 

With this enhancement, you can see cost entries 
made from the Work Order / Costs Tab, the Quick 
Post windows listed above, and from the new 
WebTMA mobile application. 

NOTE: Quick Post Materials will be a quick follow. 

 

One Signature for Multiple Key Adjustments 

 

Summary: When you make adjustments to several 
keys for one person, you can select all key lines and 
the person only has to sign once.  

Details:  

The convenience and time saved by this feature is 
substantial. For example, when Technicians pick up 
several keys at one time, they only have to sign once 
instead of individually for each key. 

Once the signature is added, the signature icon for 
each selected line has a different background color 
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Path: Material > Key Management > Key Adjustments–
8 Issue Key 

 
Path: Material > Key Management > Key Holder / 
History Tab 

before the record is saved. You can click the icon to 
view the signature. 

After the record is saved, the signature icon has a 
white background and can also be clicked to see the 
signature, but it cannot be changed. 

NOTE: The signature carries over to the Key Holder / 
History Tab.  

 

Browse Queries Window Now Has Print and Export 
 

 
Path: Reports > Browse Queries 
 

Summary: The central location for finding all your 
saved queries, the Browse Queries window, now has 
Print and Export capability. 

Details:  

Frequently, you need to send your query information 
to others. Being able to print or export all or part of a 
query gives you the convenience of looking through 
all system queries from a central location and printing 
or exporting whatever you need to anyone, 
anywhere.  

Currently, the Print option is only available on the 
Work Order Form and returns the standard Work 
Order Report, but it will be available for others in 
time. 

When you have selected a Form and Query, the 
resulting list includes Print and Export buttons at the 
top right of the page. 

The Export button gives you the option to download a 
page or all pages to an Excel spreadsheet where you 
can review and manipulate the results. 

On the Work Order Form, click the Print button to see 
check boxes for each row, and the Print button 
changes to Submit. Select the desired lines and click 
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Submit to download a .pdf file of a Work Order 
Report. 

 

Deactivation Change for Certain Records 
 

 

Summary: Default information used for Corrective 
Work Orders for Master Checks or General 
Inspections now prevents you from deactivating 
certain records until those records are amended. If 
you clear the Active check box on the records, you 
are alerted that the action is not permitted. 

Details:  

This change applies to the following records: 

 Priorities (Lookups) 

 Work Order Types (Lookups) 

 Repair Center 

 Task 

 Trade 

For records included in one of the Corrective Work 
Orders processes (Master Checks or General 
Inspections), an attempt to deactivate the record 
results in an alert, and you are unable to deactivate 
the record. 

We want to assure that defaults for these processes 
do not interfere with completing work requests from 
the new WebTMA mobile application.  

Note that, if the record is no longer a default for 
Master Checks or General Inspections, it can be 
deactivated. 

 

Client Info Fiscal Year Preferences Options Added for Utilities 

 
 

 

Summary: If you use the Utilities additional module, 
you can now add a Fiscal Year Description and include 
Fiscal Year Placeholders for the description of the 
Fiscal Year. 

Details:  

This functionality augments the Starting Month and 
Starting day of the Fiscal Year already in place. For 
now, this only applies to the Utilities module. 

As illustrated in the following topic, the Fiscal Year 
field on the Utility Ticket window is autocompleted 
when you create a new record. It is based on these 
Fiscal Year settings. 

The new fields give you more flexibility in the date 

format. Use the  plus button to add Placeholder 
selections similar to using keywords in Email settings. 
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Path: Admin > Client Info / Preferences 
 
 

Enter text in the Fiscal Year Description field followed 
by your desired Placeholder selection. See examples 
below. 

Here are the abbreviations you can add from the 
Placeholders to the Description. 

• {ys4} - year start with 4 digits: 2026 
• {ys2} - year start with 2 digits: 26 
• {ye4} - year end with 4 digits: 2027 
• {ye2} - year end with 2 digits: 27 
• {ms} - month start with 2 digits: 02 
• {me} - month end with 2 digits: 01 

Examples of description text entries: 

 FY{ye4} - FY2027 

 FY-{ys2}-{ms} - FY-26-02 

 

Utility Ticket Fiscal Year Auto-Completion Added 
 

 
Path: Organization > Utility > Utility Ticket / Identity 
Tab 

Summary: The Fiscal Year field added to the Utility 
Ticket window is now completed automatically. 

Details:  

When you enter the Billing End Date on a new Utility 
Ticket record, the Fiscal Year field is auto-populated 
based on the settings made by your WebTMA system 
administrator in Admin > Client Info / Preferences as 
described in the previous topic. 

Having a Fiscal Year identified is helpful in tracking 
your Utility records and when creating reports. 
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February 3, 2026 
 

VOC – Mass Import Technician Template 
 

 
 
Path: Admin > Mass Import / Templates 
 

Summary: A new Technician Template has been 
added to Mass Import. 

Details:  

You now have the opportunity to save time by 
importing new or updated Technician information 
such as Charge Rate, Repair Centers, and many other 
fields. 

Currently, only one Trade is imported; however, that 
will change soon. 

This is the February Voice of the Customer 
enhancement. It was a feature request from the 
WebTMA Knowledgebase Community and had several 
up votes. WebTMA has evolved into the solution it is 
largely through great feedback and suggestions 
provided by our clients. 

 

Mass Import for MWI Now Has GIS Fields  
 

 
Columns added to the Templates listed at the right 

Summary: Several Mass Import Templates now 
include GIS-related fields for maintenance-worthy 
items (MWI). 

Details:  

Importing this information allows you to use the 
information with TMA’s internal GIS map and MapIt! 
function. 

The GIS fields are: 

• GIS Id 
• Latitude 
• Longitude 

 

The fields have been added to the following 
Templates: 

• Area 
• Asset 
• Building 
• Equipment 
• Floor 

 

In addition, the Area Template now includes Area 
Function.  
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Report Writer New Form – Purchase Order Items 
 

 
Path: Reports > Report Writer / Identity Tab 

Summary: A new Report Form, Purchase Order 
Items, has been added to the Report Writer window. 

Details:  

This Form was added to allow you to report on 
distributions for Purchase Order items so you can see 
what distributions are connected to the items. 

If you have previously wanted to include these items 
in your Purchase Order reports, this Form gives you 
the resource to do that. 

The new Form groups PO Item numbers in your 
report. 

 

 

Service Vendor Field Added to Equipment Search 
 

 
Path: Organization > Equipment > Record–Find 
 

Summary: Service Vendor is now available for 
queries and column selections for Equipment search 
and browse actions. 

Details:  

This is a free-form text field in the Contact 
Information Section of the Equipment / Identity Tab. 

If you use it to identify the Service Vendor by name, 
phone, or other detail, you can easily search and 
query the field. 

NOTE: Your WebTMA Administrator has the option to 
include the Service Vendor field. 

 

 

Building Work Orders Tab Enhanced 
 Summary: We have enhanced the Building / Work 

Order Tab to include child locations. You now have a 
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Path: Organization > Building > Building–Work Orders 

wholistic view of all work orders affiliated with the 
Building. 

Details:  

Work Orders for Areas and Floors that are associated 
with a Building are now visible on the Building / Work 
Orders Tab. 

Work Orders written for Areas or Floors within the 
Building are displayed on both the Areas / Work 
Orders Tab and the Building / Work Orders Tab. 

Work Orders for related Areas, Floors, and Buildings 
are reflected on the Facility record as well. 
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January 20, 2026 
Release Notes for 2025, 2024, 2023, and 2022 is available in the Knowledge Base. 

 

RRule Now Supports “By Month” Selection 
 

 

Summary: The RRule repeating pattern for recurring 
events such as PMs now gives you several 
configurations that allow you to specify specific 
months for your selected interval. 

Details:  

This allows you, for example, to select Every 1 Month 
but choose only the months that apply rather than all 
months. You can also specify certain days of the 
month. 

You can use the same process for weekly, daily, and 
yearly. 

 

Warehouse API Endpoints Added 
 

 

Summary: Endpoints for Warehouses in WebTMA 
have been added to Swagger. 

Details:  

These are now available in the Swagger WebTMA 
Platform API. 

These new APIs are fully described in our Swagger 
documentation. 
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January 6, 2026 
Release Notes for 2025, 2024, 2023, and 2022 can be found in the Knowledge Base. 

 

VOC – AI Email Work Request  
 

 
Path: Client Info / Inbound Emails Tab 
 

 
Path: Transactions > Request > Request Log 
 

Summary: If you have the Platform API module, you 
have the option to set up a standard “maintenance” 
email address for Requests. WebTMA can convert the 
message from this email address into a record in the 
Request Log window and optionally use AI to enhance 
the request record. 

Details:  

The process involves a certain amount of setup in 
Client Info using the new Inbound Emails Tab. This 
Tab is only visible if you have the additional Platform 
API module. 

You can inform your Requestors of the new email 
address. If details about the Requestor are in User 
Management > Requestors, that information such as 
location and phone number are automatically inserted 
in a new AI generated Request Log record. 

The requestor’s message is included in the Action 
Requested field, and if you choose, AI suggests a 
Task Code based on the content of the message. 

Fields that contain information suggested by AI are 
indicated by this icon . 

NOTE: A separate document will be available for 
details on the full setup. 

This is the January Voice of the Customer 
enhancement. It was presented in the Election for 
Direction during UC 2025. WebTMA has evolved into 
the solution it is largely through great feedback and 
suggestions provided by our clients. 

 

New Fuel Budget Code 
 

 
Path: Organization > Lookups > Fuel Types 

Summary: A new Budget Code field on the Fuel 
Types window applies to Credit Accounts for the Fuel 
& Oil window. 

Details:  

This applies to Credit Accounts and is set up in 
Lookups > Fuel Types.  

The Budget Code field on the Fuel & Oil window 
applies to Debit Accounts.  
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Lease Management Search and Query Selections Added 
 

 
Path: Organization > Lease Management > Records 

Summary: New selections have been added to the 
drop-down list for Lease Management queries. 

Details:  

The searchable and reportable list now includes the 
following sections from the Identity Tab and their 
related columns: 

 Brokers 

 Amendments 

 Appraisals 

 Estimates 

 Tax 

 Responsibilities 

 Punch List 

In addition, Schedule information from the Schedules 
Tab is available. 

 

Lease Number Field Added to Work Order 
 

  
Path: Transactions > Work Order > Records / Identity 
Tab–More Information Section 

Summary: When you generate a Work Order from 
the Punch List section of Lease Management records, 
the Work Order window now includes a Lease Number 
field. 

Details:  

Since the additional Lease Management module 
includes a Punch List where you can generate a Work 
Order if needed, this helps you identify the source of 
the Work Order. 

This is like Requests and Projects, that are also 
indicated as the source of a Work Order when 
applicable. 
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Custodial Point Request Details Added  
 

 
Path: Transactions > Request > Request Log 

Summary: When you create a Point request from the 
Custodial Inspection window, additional information is 
now included in the Request record. 

Details:  

In the Action Requested field, you can now see the 
following information: 

 Custodial Inspection # 

 Inspection Code 

 Inspector 

 Custodial Deficiency  

 Inspection Quantity 

 Rating Description 

 Rating Score 

 Comments 

In addition, any Linked Documents are added to the 
Linked Documents section of the Navigation panel. 

 

Fiscal Year Added to Utility Ticket Window 
 

 
Path: Organization > Utility > Utility Ticket / Identity 
Tab 

Summary: The Fiscal Year field has been added to 
the Utility Ticket window. 

Details:  

You can enter the year of your choice. 

NOTE: This field was available in a previous version 
of the application. 

 

Progress on Database Views in Knowledge Base 
 
Click to open 
https://knowledgebase.tmasystems.net/hc/en-

Summary: WebTMA has heard your requests for a 
complete list of database views. These are used for 
reporting by SaaS clients with Direct Database 
Connect or the Business Intelligence module. On-



  44 

us/articles/23648067588493-List-of-WebTMA7-
Database-Views 
 

premise clients are also urged to use these Views for 
reporting rather than query directly against 
transactional tables. 

Details:  

Although not fully completed, the Database 
Definitions section of the Knowledge Base currently 
has 415 views with more being added each week. 

The section includes a “List of WebTMA7 Database 
Views” article that is a table of the View names with a 
short definition. Many rows in the table are linked to 
the full View.  

Ultimately, the table will connect to Views for all 
rows. Click a link to open a full View in a new tab. 
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